
 

 

NIAGARA VIDEO HDi-250 

Industrial HD Video Recorder 
  

Operations Manual 
 
  

  

 

 
 

 

 

NIAGARA VIDEO CORPORATION 

5627 Stoneridge Drive, Suite 316 

Pleasanton, CA 94588 

http://www.niagara-video.com 

Tel. +1 (925) 399-7201 

  
Firmware v3.1+ 

Manual Version 3.1.2a  December 2017, Add SDI 5/21/2018 

 

  

  

  

  

http://www.niagara-video.com/
http://www.niagara-video.com/


 

 

 

 

                                       NIAGARA VIDEO HDi-250 High Resolution Video Recorder                        

Page 2 

  

  

  

  

NIAGARA VIDEO HDi-250 Manual 

Warranty and Disclaimer 

NIAGARA VIDEO reserves the right to make changes and improvements in its products at any 

time without notice. 

Warranty:  NIAGARA VIDEO makes no warranties, either expressed or implied, regarding the 

associated hardware/ firmware/ software package, its merchantability or its fitness for any 

particular purpose.  In no event shall NIAGARA VIDEO be liable to customer for any special, 

indirect, incidental or consequential damages in any way arising out of or relating to the 

product(s). NIAGARA VIDEO’s liability to customer for direct damages arising out of or relating 

to these products shall in no event exceed the total amount actually paid by customer for the 

product(s).  Customer’s sole remedy within the warranty period is repair or replacement, at 

NIAGARA VIDEO’s discretion, of a unit deemed by NIAGARA VIDEO to be defective. 

Copyright:  This manual and the hardware/firmware and the software are copyrighted and/or 

trademarked by NIAGARA VIDEO.  All rights are reserved.   Some additional software is 

licensed under GPL – General Public License.   Per GPL, source code is included with each 

unit. MPEG-2 and MPEG-4 are used under license from MPEG-LA.  This manual may not, in 

whole or in part, be translated or copied to any other form or medium without the prior written 

consent from the publisher, NIAGARA VIDEO.  The Command Protocols are copyrighted and 

may not be used in other devices without written license from NIAGARA VIDEO.  Control 

Firmware & Manual © Copyright 2018 NIAGARA VIDEO.   Other trademarks are owned by the 

firms mentioned. 
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NIAGARA VIDEO HDi-250 Introduction 
First, about the model number:  We called it the HDi-250 because we planned to include a 

250GB hard drive.   Currently we use a 500GB hard drive, but, the name stuck. 

  

In its simplest form, the HDi-250 will record video and play it back.  It will record in several 

formats: 

·      MPEG-4 (.mp4), high quality, compact file size, resolution the same as input. 

·      Generic MPEG-2 format (.mpg), maintaining the same input resolution, i.e. 1920x1080. 

·      DVD compatible format (.vob), resized to 720x480.  

  

The HDi-250 offers 3 sets of input connections: Composite Video(720x486), HDMI(up to 

1920x1080) and Component(up to 1920x1080). 

·      Recording: Press and hold the Record button. 

Playback: Press the Play button to play the most recently recorded file. 

  

Be certain to explore and become familiar with the Front Panel Menu System.  Most settings 

need to be made only once, then SAVED. 

  

 Rear Connections 

 

 Left Side - System   Right Side - Video/Audio 

Power 110-240 VAC    Y In/Out 

Keyboard/Mouse – P/S2    R-Y In/Out 

HDMI Out – System    B-Y In/Out 

VGA Out – System    Audio L&R In/Out 

USB x2      HDMI In/Out 

Gigabit LAN 

Computer System Audio  

NOTE: The RJ-45/LAN connector is the  

only connector generally used on the left side. 

Product may vary from the illustration 
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NIAGARA VIDEO HDi-250 - Quick Start Guide 

SDI Note:  

The HDi-SDI has only 3 rear BNC connectors: 

Video In - connect to your SDI source 

Video Out - connect to your SDI monitor or destination 

Reference - Connect several units to your reference signal. 

 

This short tutorial is designed to get you recording Right Now. 

The HDi-250 is engineered so you can  

● Plug in the power 

● Connect your video source(s) 

● Turn in on 

● Press Record to record 

● Press Stop to Stop 

● Press Play to play the most recent file 

The Quick Start section does not cover all the options, just enough to get you going in the 

simplest way. 

Capabilities 

● Automatic Video Format Detect from 35 formats from 720x480i to 1920x1080i/p 

● PAL & NTSC 

● Automatic Format Select - Chooses the highest resolution format available 

● Video Streaming During Record or Play - High Definition with automatic down-convert to SD. 

● Easy to change video inputs:  

● HDMI/Component/Composite or SD/HD SDI for the SDI models 

● Auto-Update from our network 

● Record files to HDD (Hard Disk Drive) 

or Direct To USB or to Optical Disc 

● Copy files to/from USB 

● Automatic Update Download in the background.  

You install at the update when you want  or just call us for a free update disc 

We will bypass some of the menu items in order to get started fast. 

These instructions apply to Serial Numbers #2017 and above with Firmware Version v3.1 and 

above.  As of this writing, the latest version is v3.1-rc18-8 as of 28 June 2017. 
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Connect Video Out 

Connect your TV Monitor to one of the Video Out connectors (OUT is the bottom row): 

●         Composite Out is a single BNC connector 

Use the RCA Audio Out connectors for audio. 

●         Component Out consists of 3 BNC connectors 

Use the RCA Audio Out connectors for audio. 

●         HDMI Out is the lower HDMI connector on the rear, right. 

(HDMI Out is preferred because it is a single cable for both video and audio, and it will display 

any video that the machine can record, regardless of the Input connector.) 

Connect Video In 

Connect your video source (camera/switcher) to one of the Video In connectors on the top row. 

●         Composite In is a single BNC connector 

Use the RCA Audio In connectors for audio. 

●         Component In consists of 3 BNC connectors 

Use the RCA Audio In connectors for audio. 

●        HDMI In is the upper HDMI connector on the rear, right. 

HDMI Audio is usually embedded in the HDMI cable.  In some cases, you may use separate 

audio via the RCA jacks. This is setable in the menus. 

 

Optical Disc Types 

The HDi Series records to hard disc or RAM, then copies video to optical disc. 

+RW, +R discs are preferred, although -R may be used for copying. 

● Make DVD-Video discs: : +RW, +R, -R 

● Copy files from HDD to disc: +RW, +R, -R 

● Record directly to optical disc: +RW only 

Note: DVD-RW (‘dash’ RW or ‘minus’ RW ) discs are not recommended.  
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Startup 

We strongly suggest that you connect your video Inputs first, and be certain that there is video 

playing to the machine.  (It can’t detect the video format if there’s no video.) 

 

Turn it on: Press and release the Power button on the front right of the machine. 

Wait about 20 seconds, the animation will play from all of the video connections.  

The animated Logo is SD/Standard Definition, so it will play on any TV monitor. 

  

During startup the front panel Vacuum Fluorescent Display (VFD) will show the current default 

values of the available features.  This feature display will continue for a little while after the Logo 

has finished.  The feature display will finish and show 

 
 

Auto Video Detect 

→ A key feature is Video Auto Detect during Startup  

At Power-On, the system will automatically detect the video format of video connected to 

Composite, Component and HDMI connectors.  (The Composite connectors are shared with the  

“Y” Component connector.  If Component is connected, you may get false detection of 

Composite.)   Remember: You should NOT have Composite and Component-Y connected 

at the same time.  

 

After it detects the values of all the active inputs, the HDi-250 will select the highest resolution 

from the active inputs. 

 

 

Basic Recording 

Press the Stop button - twice 

The system will choose the connector with the highest resolution input available. 

If you have only Composite In, you will see 

 

and you’ll have Live video ‘loop through’ from your Composite Input to all of the outputs. 

To change inputs, press the > Right or < Left buttons.  Use < or > repeatedly and the system 

will perform signal detection for each input. 
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Choose One Format for best results (save disc/memory space. 

The default is NIAGARA VIDEO’s Dual Stream Recording.  This records both MP4 and VOB file 

formats simultaneously. 

 

Press the RECord button to record.  The hard disk drive (HDD) is the default Record Target. 

Press STOP to stop recording. 

Press PLAY to play the most recent file. 

That is the main purpose: Record, Stop, and Play.   

Making a DVD 

The default recording formats are MP4 and .VOB, both at the same time.  We call it 

DualStream. 

Press the Play button once to see the recorded file names on the front display.  You may see 

MP4 and VOB files listed for the same filename. 

Press < or > to see more files. 

Press the Enter key to Mark the files you want for your DVD.  A “+” will appear to show that it 

has been marked.  MP4 and MPEG-2 files are converted to VOB files before making a DVD, so 

marking only VOB files speeds up the DVD process. 

 

Press the Down button when you’re finished marking files,  to see the File Operations Menu. 

(Play, Down) 

 >>>>  

● Insert a blank DVD disc (+R, -R, or +RW) into the DVD drive. 

● Press the < or > button and arrow over to DVD-Video (No Menu).  You may also choose 

DVD-Video (Text Menu) or DVD-Video (Icon Menu) 

● If there are files on a +RW disc, the display will show 

Erase Old Disc Files ? 

No 

Arrow < or > to see “Yes”.   

Press the Enter button to begin. 

You will see the flashing “#” along with Busy at the upper right of the display. 

 

When the disc burn is complete, the disc will eject and you can choose to make another copy. 

When you’re all finished, you may keep the files used or delete them. 
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NIAGARA VIDEO HDi Menus 

(Firmware v3.1 and above) 

At power-on the unit will play it’s opening animated logo video so you’ll know it’s working 

properly.  The animated opening is in SD (Standard Definition), playable to any TV monitor.  It 

will also display all of the current settings on the front panel Vacuum Fluorescent Display (VFD).  

Finally it will show “Ready”. 

  

Control Buttons 

Left side: Navigation “Arrow” buttons 

Top Row: Menu, <<, II, >> 

Menu: Toggles the Menu System.  

“<<”: Reserved 

“I I”: Toggles Pause during Play or Record.  

      Engages E-E Loop-through when in Stop. 

“>>”: Reserved 

  

Bottom Row: “Enter” button, “Stop”, “Play”, “RECord”. 

also, front USB jack and main Power button. 

Enter: Engages the shown selection.  

       Marks a file for further action when Play Menu is shown. 

Stop: First press Stops record or Playback. 

Stop: Second press:  Causes Live/Loop-Through video  

 

Play: Press #1 (THE FIRST PRESS)  shows the most recent file recorded. Use < > to scroll. 

         Press #2 Plays the displayed file. 

 

REC: Press #1 engages E-E/Live Loop-Through  (if the video is not visible on your monito) 

Press #2 starts thhe RECording. 

         Press #3 Shows Record Duration menu. 

             Scroll <> to see Custom Duration, 4 hours, 2 hours, 1 hour, ½ hour. 

             Custom Duration is Time of Day 

             Recording stops when time limit is reached. 

       

There are 2 menus available by pressing the Menu button, followed by Down or Up. 

 UP shows the System Menu 

 DOWN shows the Video Menu 

There are 2 menus available by pressing the Play button followed by < or > or Down. 

 < or > shows the available files.  This is  the File Menu  

 DOWN goes to the File Operations Menu for copying files, etc. 

 

NOTE:  In the menus, the minus sign “-” indicates the default setting. The plus sign “+” indicates 

your choice after you press the Enter Key.  

In the Play Menu, the “+” indicates a file marked for Copying, Making a DVD, or Deletion 
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The menus are “circular”. Going all the way to the bottom takes you to the top item. 

The Display - Topics & Items 

  Display Top Line is the Topic 

  Display Bottom Line is the Item 

NOTE: Menus with a “?” in the lower right corner will ask you to confirm before taking action. 

Terminology: 

 DisK with a “K” means a hard disk drive (HDD) 

 DisC with a “C” means an optical disc like DVD+RW, DVD-R, DVD+R. 

 VFD means the front panel Vacuum Fluorescent Display 

 

New Addition: “Reset” [Version 3/2e] 

The only time the machine will ‘hang up’ (not respond to buttons, Telnet, or RS232 commands) 

is when the optical disc is physically faulty.  You try to copy to optical disc and it takes ‘forever.’  

Press and hold Stop, and touch Enter.  This causes a reset of the HDi. 

 

The Main Menu 

 Press the blue Menu button and see  

  (The Menu button toggles between menu 

selection and the File/Play menu.) 

Press Enter to Eject the Optical Disc  

 

You can use either Right Arrow > or Left Arrow to navigate the Menus. 

In this example, press the Right Arrow > 

Eject Front USB Safely 

 
Choose this to copy to the front USB connector. 

This flushes the buffers and will prevent lost data. 

Format Front USB NTFS 

 
This will erase everything on the USB drive with a standard Windows NTFS format. 
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Format Data HDD NTFS 

 
This formats the Data Hard Disk Drive (HDD) with a Windows format. 

Format Data HDD EXT4 

 
This formats the HDD in a Linux disk format. 

Stop/Remove Data HDD 

 
This is for systems equipped with a removable HDD.   

This setting spins down the disk to permit safe removal. 

Start/Mount Data HDD 

 
This permits replacing the HDD and spins it up to tell the system that it exists. 

Reboot Into Memtest86 

 
This is a diagnostic to check the system memory.  It takes several hours to perform a thorough 

test. 

Restart HDi Recorder 

 
This is a “Warm Restart” of the video system without power cycling. 
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Check for HDi Updates 

 
Generally, the system automatically downloads firmware updates in the background.  This item 

will not show If the system is not connected to a network.  Contact us at support@niagara-

video.com for updates.  Press Enter and this menu item will change to reverse video (black on 

white) and say “HDi Can Now Be Updated.”  Press Enter again to install Update. 

Erase (Re)Format Disc 

 
This erases a DVD+RW disc.  This is required in order to re-use a +RW disc that has been 

recorded as a DVD-Video disc and before using a brand new +RW disc.  If a disc only has files 

(MP4, MPG, VOB), new files can be added to the disc. 

 

The Video Menu - Menu Down 

Press the blue Menu button and see 

 
 (The Menu button toggles between menu selection and the File/Play menu.) 

Press Enter to Eject the Optical Disc  

Press the white Down button to begin the Video Menu section 

 

Record/Playback Target 

 

The Target is where you want the recordings to be saved and from where they are played.  The 

> Right and < Left buttons let you choose HDD, USB or Optical Disc as the Record/Playback 

Target. 

 

IMPORTANT NOTE: Use only +RW discs to record directly to an optical disc. You may use “-R” 

or “+R” discs for copying operations, but not for Direct Record. 

  

mailto:support@niagara-video.com
mailto:support@niagara-video.com
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NOTE: The “-” dash at the front of “-Internal HDD/Hard Disk” means this is the default setting at 

this time.  Pressing the blue Enter button makes the ‘-’ become ‘+’ to indicate that this value has 

been selected.  When you Save Your Settings, that value will become the default. 

 

ALERT: If you have selected the target as “Direct To Optical Disc”, use only +RW discs.  +R or -

R discs will be rejected.  

 

 Video Out Connector(s) 

 
HDMI models: The HDMI output is always enabled.  User the < and > keys to enable the 

Composite analog or Component analog outputs. 

SDI models: The SDI Output is always and only enabled since there is only SDI output 

available. 

Audio Input Selection 

 
HDMI Models: HDMI usually has audio embedded in the HDMI signal so only one cable is 

required.  For some applications you may want separate audio to come through the analog RCA 

connectors.   

Press < > to select which audio will be used with the HDMI input. 

SDI models: Since there is only SDI input available the only option is embedded audio. 

Audio Output Selection 

 
HDMI models: Sets HDMI Audio Output to be through the RCA output jacks or HDMI only 

SDI models: Since there is only SDI input available the only option is embedded audio. 

Recording File Format 

 >  >  

Select the file format you wish to record.  The default is MP4, but you may choose HD MPEG-2 

or .VOB (MPEG-2 resized for faster DVD creation). 
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Record DVD DualStream 

 
You can set it to record the main HD format (MP4 or MPEG-2) only, or to add simultaneous 

recording of a SD VOB file. [This is our standard setting to make both MP4 and VOB files at the 

same time.  That way, we have high quality HD video on the hard drive as well as 720x40 VOB 

files for making DVDs if we want to. 

Video Quality-Time/DVD 

 >  >  > 

 >  

Video Quality-Time/DVD sets the quality of VOB files used to make DVD-Video discs. 

The default is -Normal Play 2 Hours. 

DVD Widescreen Format 

 >  

This affects the aspect ratio of the VOB image.  Choose “Anamorphic” if you plan to make DVD-

Video discs. Choose “Letterboxed” if you plan to play the Standard Definition .VOB files on a 

computer or HD TV. 

Timestamp In Recording 

 >  >  

 >  

The HDi-250 can superimpose Date, Time or both in the picture. 

You may also choose in which corner of the image to display the Date/Time   

Save/Load The Settings 

 
Save/Load The Settings is very important.  This saves your settings so they will be recovered 

automatically when you re-power the unit. 
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The System Menu - Menu-Up 

 
From the Main Menu screen, press UP 

The first item is the Help Menu.  Press < > to see help hints. 

The second item is the Version display. 

 
This also indicates if an update has been downloaded and is ready to install. 

Button Locking Control 

 
For your protection, you can lock the front panel buttons to prevent accidental or unauthorized 

operation.   

. 

Press Enter to lock the buttons to prevent accidental pressing.  Only the arrow and Enter 

buttons remain active.  To unlock, press an Arrow button, then Enter. 

 

You can also set a Supervisor PIN to prevent unauthorized operation. 

Remember the PIN! It cannot be recovered.  You’ll need to reinstall the software by 

downloading it from niagara-video.com or call NIAGARA VIDEO if you need a reinstall disc. 

Video Output For Stop 

 >  >  

When the unit is in Stop, it can 

● Show a blank screen 

● Display the last frame that was Played 

● Display Live Video from the selected input. (E-E)  This is the current default. 

Record Safety Choice 

 >  >  

● “Direct Live Record” - If you press Record with a Live picture, it will record. 

● “Use One Button Record” - Records with a single button press.  No safeguards. 

● “Use Two Button Record” - Press Play while holding the REC button. 
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Autodetecting Video In 

 >  

“Use Autodetect Results” is the default and recommended setting. 

“Manual Override” permits manual selection of the input’s frame rate, image size, TV Standard.  

There are 35 choices for HD video, so Autodetect is by far the easiest and most reliable. These 

will be available from the Video Menu (Menu-Down) 

Timezone Offset 

 
This sets the number of hours +/- UTC/GMT.  Eastern Standard Time is UTC-5. 

Use the < > arrows to change, then press the Enter button. 

Set The Date And Time 

 
Press Enter to begin.  

Press Enter to move the cursor to the next position 

Use < > to increment or decrement a numeral. 

Keep pressing Enter until the cursor goes off the end to the right. 

Be certain to Save Your Settings after changing Date/Time. 

Deck Group & Number ID 

 
Used for RS-232 Serial Control for more than one unit.  There can be many groups and many 

ID numbers within a group.  In this way, the RS-232 command “RECS” can cause many 

machines to start recording at the same time.  The Deck number also identifies multiple units 

used on a network 

Network 0.0.0.0 

   
After startup, you’ll usually see “Network 0.0.0.0.   

Press the Right Arrow > to see “Use DHCP Address.”  Press Enter and the HDi-250 will ‘ask’ 

your network router to assign an IP address for network control. 



 

 

 

 

                                       NIAGARA VIDEO HDi-250 High Resolution Video Recorder                        

Page 18 

Remote Command Connect 

 >  >  

You can control the HDi-250 over a network using Telnet or via RS-232. 

Press the Enter Button, then the < > buttons to select. 

Network Sharing  

 >  >  

The HDi-250 can share its files with a Windows network. 

Windows Explorer will usually show the device as “HDi_00.” 

Video Streaming  

 >  

The HDi-250 can stream video to your network during Record and Play. 

With the free “VLC Media Player” program, click on “File” then “Open Network Stream”.  The 

stream address for playback is “//http://<IP Address>:8090/playback” 

That means, “use the IP Address found in Network setup, and use Port 8090.” 

To view the stream while recording, use “//http://<IP Address>:8090/record” 

 

If your institution has a central streaming server, Use the > arrow to select Remote Server. 

 

NOTE: Telnet/IP control, Network Sharing, and Video Streaming are not available unless a 

network address has been enabled. 

Special Debug Settings 

 
When “ON”, additional status information is sent through the VGA port to a computer monitor. 

HDi (Re)Install 

 
Insert a blank DVD Disc (+R, -R, +RW) and press Enter. 

The system will copy all its files and make a Boot/Reinstall disc as your primary backup. 

See HDi Install Disc section, belos. 
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Save System Menu Setting 

 
This is a VERY important setting.  You should save your settings whenever you make a 

change.  That way, your settings will be automatically restored at the next power-on. 

The File Menu - Play 

Press the Play button to see the recorded filenames on the second line. 

The first file shown is the most recent file recorded. 

The top line of the display shows something like this example: 

 

“FILE” is the name of this menu 

“492Gh” shows the space available on the video hard drive (HDD) and the Record Target. 

 The ‘h’ means files will be recorded to and played from the HDD. 

 The ‘u’’ means files will be recorded to and played from USB. 

 The ‘o’ means files will be recorded to and played from the Optical Disc. 

“319” is the size of the current file 

“0M” shows the total size of all marked files. 

Use the arrow buttons < and > to scroll through the recorded files. 

Marking Files 

You must first “Mark” a file so you can:  

● Delete it 

● Copy it to USB or the Optical Drive 

● Include it on a Video-DVD disc 

Press the Enter button to Mark a file. A “+” symbol will appear to the left of the filename. 

Press Enter again to UNmark that file. 

Press <, >, and Enter to mark more files. 

File Operations Menu - Play-Down 

You must Mark your files before using the File Operations Menu. 

Press the Play button, then press the Down button. 

Use the < and > buttons to select the operation. 

This menu is also reachable from the Status Menu any time you see filenames. 
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Copy Files to USB 

 
Insert a USB drive into the front USB slot and press the Enter button. 

An error will be shown if you press Enter before inserting the USB drive.  The system will detect 

the USB drive when you insert it.  Press Enter again to perform the copy.  You will see Busy at 

the upper right of the display and Done when copying is complete.. 

Copy Files To Optical Disc 

 
You can copy files to the optical disc if optical disc is NOT your Record/Playback Target.  Your 

files should be on the Record Target:  Hard Disk Drive (HDD) or on a USB drive. (Not already 

on the optical disc.) 

 

Mark your files, insert a blank disc, and press Enter. 

If the disc is +RW and already has files, the system will ask if you want to erase the old files. 

If the disc is a +R or -R that has already been recorded, the system will show “Disc 

Unavailable.”  

 

NOTE: Optical Discs take a long time to mount.  Please wait until the disc light stops blinking 

AND the “#” in the upper left corner stops blinking AND the “*” stops blinking.    

You will know that the disc is stable when the “*” asterisk is solid and not flashing. 

Make DVD-Video Disc 

 >  >  

There are 3 menu styles available for making DVD-Video discs: 

● No Menu 

● Text Menu 

● Icon Menu 

We prefer Icon Menu because it’s the best looking, but No Menu is the fastest. 

Making a DVD-Video disc is faster if you mark only .VOB files. They’re already the proper 

format. 

 

Insert a blank disc. WAIT until the “*” becomes solid and the disc drive light stops blinking. 

Press Play, press Enter to mark your files.   Press “Play” then press “Down” for the File 

operations menu.  Arrow < or > to find the kind of DVD disc you want to make.  Press Enter. 
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Delete Files 

 >  

Delete ALL files will delete all video files from the HDD whether they are marked or not. 

Delete Selected files will delete all marked files. 

Convert Files to DVD Format 

 
This converts marked MP4 and MPEG-2 files to become .VOB files, appropriate for making 

DVD-Video discs. 

Grab Image For DVD Menu 

 
NIAGARA VIDEO provides a nice background for your DVD menus, but you may like something 

else.   

PLAY a video, arrow Down then < > arrow to “Grab Image for DVD Menu.” 

Press Enter when you see the frame you like. 

HDi ReInstall Disc 

The bootable  3+ GB full reinstall disc is a complete version of the firmware running off the DVD 

instead of the SSD. 

 

Make this disc by inserting a blank DVD disc (+R, -R, +RW) into the DVD drive and using the 

Menu system to go “Menu Up” to Make Re-Install disc.  It takes about an hour. 

 

Using the ReInstall Disc 

Aside from being a bit slower at times because of the DVD access times compared to an SSD 

it's just like the factory installed systems 

 

This allows you to "Try before you buy" and use the new version without installing it 

permanently to be sure you understand/like/want the features of the newer software. If so, you 

can arrow up to the Reinstall menu and install the new software to the SSD 
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Update Disc 

The bootable 150+ MB update disc on the other hand just update the SSD to the newer 

software and then reboots and ejects the DVD 

 

You can download a much smaller Update file from our web site.  Pull down the “Support Menu” 

and select Downloads.  Download the appropriate “.ISO” file and burn it to a DVD or CD disc as 

a “Disc Image.”   Boot the Update disc and the update installs itself automatically. 

 

Both the Reinstall disc and the Update disc can work with an existing or blank SSD although the 

update disc would need to download the videos and would not have all the GPL source that 

shipped on the original SSD. If that is desired after an SSD failure, you need to use the full 

reinstall disc which is much slower to download in a classic speed/space trade off. 

 

 

 

 

 

 

 

 

 

 

 

 

 


